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Curs Graphic Design - USCAnnenberg 
 

Arta comunicării vizuale, denumită și design grafic (sau design vizual), constă 
în amalgamarea imaginilor, ideilor și cuvintelor în vederea transmiterii de informații 
către o audiență. 

Reprezintă pur și simplu un design de comunicare, fiind o abordare prin care 
se transmit informații, imagini și idei prin intermediul designului. 

Acest design poate varia de la simplitatea unei sigle de afaceri până la 
complexitatea aspectului paginilor unui site web. Prin intermediul designului grafic, 
se transmite mesajul unui eveniment, produs sau campanie, reprezentând totodată 
un mod de exprimare artistică. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
Capitole curs: 
 

1. Introducere 
2. Crearea unui Document Nou 
3. Navigarea în Documentul Tău 
4. Înțelegerea și Crearea Artboards 
5. Crearea Formelor și Adăugarea de Umplere și Contururi 
6. Utilizarea Instrumentului Pensulă 
7. Înțelegerea și Desenarea Punctelor de Traseu 
8. Utilizarea Textului și Crearea Contururilor 
9. Exportarea 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 

CAPITOLUL 1: 
Introducere 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Adobe Illustrator CC este un program de editare a imaginilor bazat pe 
vectori. Illustrator este folosit pentru a crea artă vectorială scalabilă pentru 
proiecte destinate atât tipăririi, cât și mediului online. Ce înseamnă imagine 
bazată pe vectori? Asta înseamnă că imaginea ta poate fi redimensionată la 
infinit fără nicio distorsiune sau pixelare. Acest lucru permite crearea de grafică 
flexibilă care poate fi utilizată la diferite dimensiuni. Acestea pot fi de ajutor 
atunci când trebuie să redimensionezi un poster sau un obiect artistic de la 8 
1/2” X 11” la un ecran digital cu proporțiile de 800px pe 600px. 
 

În acest tutorial, vom acoperi elementele de bază ale lucrului cu 
Illustrator, cum ar fi înțelegerea traseelor, crearea formelor, crearea și utilizarea 
artboards, lucrul cu tipografii și altele. Vei dobândi cunoștințe practice despre 
Illustrator. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CAPITOLUL 2: 
Crearea unui document 

nou 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



 

 

1. Deschideți Adobe Illustrator. 
2. Du-te la Fișier > Nou… (File > New…) 
3. Va apărea o fereastră de dialog care îți va permite să setezi parametrii 

pentru fișierul tău. În Illustrator, lucrezi cu Artboards (table de lucru). 
Observă că poți să schimbi ușor dimensiunea artboardului pe măsură ce 
lucrezi, dacă ai nevoie de mai mult spațiu. Poți chiar să creezi mai multe 
artboards - vom discuta despre asta în detaliu mai târziu. 

 
Pentru acest tutorial, vom crea un logo simplu. 
 
Dă un nume fișierului tău. Pentru început, să începem cu un singur Artboard 
cu dimensiunile de 600px pe 600px. Vom lucra în pixeli, dar simte-te liber să 
lucrezi în orice unități te simți confortabil. În cele din urmă, dorim să fie în 
orientare peisaj (landscape). 
 
După ce ai făcut toate aceste ajustări, apasă OK. 
 
 
 

 
 
 
 
 
 



 

 

 
 
 
 
 

CAPITOLUL 3: 
Navigarea în document 

 

 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
Fereastra ta va arăta astfel. În cadrul Illustrator-ului, este destul de ușor 

să navighezi în jurul documentului tău folosind Instrumentul Hand (H) și 
Instrumentul Zoom (Z). Încearcă să folosești aceste instrumente pentru a 
muta documentul și pentru a face zoom în el sau zoom afară. Folosește 
scurtăturile lor (H, Z) sau dă clic pe ele în bara de instrumente (marcate în cerc 
mai jos).  
 

Sfat: Dacă ții apăsată tasta spațiu, poți folosi instrumentul Mână în timp 
ce folosești majoritatea celorlalte instrumente. Odată ce eliberezi tasta, 
cursorul se va întoarce la instrumentul pe care îl foloseai anterior. Acest lucru 
este util atunci când trebuie să te deplasezi în jurul documentului în timp ce 
folosești un instrument și economisește timpul necesar pentru a comuta între 
instrumente. 
 
 

Când folosești instrumentul de zoom, implicit acesta face zoom la 
interior. Ține apăsată tasta Alt în timp ce folosești instrumentul de zoom pentru 
a-l schimba în modul de zoom-out (zoom afară). Vei observa că cursorul acum 
afișează o lupă cu un semn minus (zoom-out) în mijloc în loc de semnul plus 
(zoom-in). 

 
 
 

 
 
 
 
 
 

 
 



 

 

 
 
 
 
 

CAPITOLUL 4: 
Înțelegerea și crearea de 

Artboards 
 

 
 
 
 
 
 
 
 
 



 

 

 
După cum s-a menționat anterior, atunci 
când creezi fișierul tău, poți să creezi mai 
multe artboards încă de la început. De 
asemenea, le poți adăuga ulterior, după 
nevoie. 
 
Când creezi un document nou, vei observa 
această secțiune aici. Poți să crești 
numărul de artboards, să setezi spațierea 
dintre artboards, să schimbi modul în care 
grila de artboards este configurată (Grilă 
pe rând, Grilă pe coloană, etc.) și să stabilești câte coloane de artboards dorești. 
 
La fel ca și înainte, le poți edita după ce ai creat documentul folosind 

Instrumentul Artboard (Shift + O) sau găsindu-l în bara de instrumente.  
 
Odată în Instrumentul Artboard, în bara de instrumente de sus, vei putea să 
redenumești Artboard-ul și să schimbi dimensiunile fiecărui artboard. De 
asemenea, poți plimba manual cursorul peste marcatori în jurul artboards 
până când apare cursorul și să îl ajustezi. De asemenea, poți plimba cursorul 
peste centrul artboard-ului și să îl muți în jurul ecranului în cazul în care dorești 
mai mult spațiu între artboards. 

 
Încă o dată, multiplele artboards pot fi 
utile atunci când dorești să ai mai multe 
lucrări de artă în același document. De 
asemenea, face ușor exportul fiecărei 
lucrări de artă individual atunci când le 
plasezi în propriul lor artboard. Vezi 
secțiunea 'Exportarea.' 
 
 
 
 
 
 

 



 

 

 
 

 
 

CAPITOLUL 5: 
Crearea Formelor și 

Adăugarea de Contururi 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Pentru acest tutorial, avem nevoie 
doar de un singur artboard pentru 
logo-ul nostru. Să presupunem că 
doresc să creez un logo personal 
simplu pentru site-ul meu. În primul 
rând, voi veni cu un concept. Doresc să 
încep cu o cutie simplă prin care vor 
trece inițialele mele. 
 
1) Dă clic pe Instrumentul Dreptunghi în bara de instrumente. Dacă apeși și ții apăsat 
pe el în bara de instrumente, vei observa o mulțime de instrumente pentru forme 
diferite la dispoziția ta. 
2) Dă clic și trage până când obții forma dorită sau dă dublu clic pe ecran până când 
apare o fereastră de dialog care îți permite să introduci dimensiuni specifice pentru 
dreptunghiul tău. Poți ajusta mereu dimensiunea manual mai târziu trăgând 
marcatorii de jur împrejurul formei sau în bara de instrumente de sus, poți ajusta 
lățimea și înălțimea introducând dimensiuni specifice. În acest caz, am creat un 
dreptunghi cu lățimea de 350 px și înălțimea de 150 px. 
 
 
3) Acum, trebuie să schimbăm conturul și 
umplerea formei noastre. Simte-te liber să 
alegi orice culoare dorești. Poți accesa aceste opțiuni în bara laterală. De obicei, 
implicit este setată o umplere albă și un contur negru. Voi da dublu clic pe caseta de 
umplere și o voi schimba într-un verde seafoam. 

 
 
4) Dă clic simplu pe caseta conturului și 
apasă pe butonul util 'Fără Umplere' sub 
caseta Contur/Umplere. Conturul și 
umplerea mea arată acum în bara de 
instrumente astfel: 
 
 
5) Forma mea arată astfel: 

 



 

 

 

 
 
 
 
 
 
 
 
 
 

CAPITOLUL 6: 
Utilizarea pensulei 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Pentru logo-ul meu, acum doresc să plasez o scriere cursivă a inițialelor mele deasupra 
dreptunghiului, în alb. În acest caz, voi folosi instrumentul Pensulă. Notă: poți utiliza și 
un tip de literă predefinit aici, dar eu doresc ca al meu să aibă un aspect făcut manual. 
 

1) Deschideți instrumentul Pensulă.  
 
2) Apăsați și începeți să desenați pe artboard-ul dvs. 
 
3) Schimbați conturul liniei în alb. Acesta este aspectul meu: 

 
 
De asemenea, puteți ajusta linia pe care ați creat-o mergând la bara de instrumente 
de sus, unde puteți schimba umplerea/conturul, lățimea liniei de contur, opacitatea și 
stilul. 

 
 
Illustrator vă oferă multe opțiuni pentru stiluri predefinite. În acest caz, am utilizat 
stilul implicit 5pt. Rotund. Dacă faceți clic pe triunghiul mic de lângă el, va apărea un 
meniu cu diferite tipuri de pensule pe care le puteți utiliza. 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

CAPITOLUL 7: 
Înțelegerea și 

Desenarea Punctelor 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
Traseele sunt segmentele de linie care alcătuiesc structura generală a operei 

de artă pe care o creați (scheletul). De exemplu, un dreptunghi este alcătuit dintr-un 
traseu care are patru linii verticale care se conectează toate, iar în colțuri există patru 
puncte de ancorare (articulațiile). Fiecare formă și obiect va avea traseu și puncte de 
ancorare. 
 

De asemenea, puteți desena propriile trasee folosind Instrumentul Pen, creând 
practic propria operă de artă în cadrul Illustrator-ului. Instrumentul Pen are câteva 
caracteristici avansate, dar vom discuta despre elementele de bază ale utilizării 
acestuia. Practic, stabiliți punctele și desenați liniile pentru obiectul dvs. de artă. Puteți 
crea atât linii drepte, cât și linii curbate. 

 
 

Pentru logo-ul meu, doresc să creez niște forme abstracte sub dreptunghiul 
meu în diferite nuanțe de verde/albastru, care vor servi ca fundal pentru titlul meu: 
"Designer Grafic și Artist". În acest caz, trebuie doar să desenez linii drepte cu 
instrumentul Pen. 
 
1) Selectați Instrumentul Pen. 
 
2) Faceți clic oriunde pentru a începe să 
desenați obiectul dvs. 
 
3) Continuați să faceți clic pentru a crea 
obiectul. 
 
 
4) Pentru a închide obiectul, faceți clic înapoi pe 
primul punct. Ar trebui să vedeți un cerc mic 
lângă instrumentul Pen, ceea ce indică că 
închideți traseul. Voi continua să creez forme 



 

 

abstracte până când se formează un grup suficient de mare pentru a adăuga titlul 
meu. 

 
 
Logo-ul meu arată acum astfel: 

 
 



 

 

Când lucrați cu trasee, puteți ajusta punctele de ancorare/trasee folosind 

Instrumentul de Selecție Directă (Direct Selection Tool).  
 
Instrumentul de Selecție Directă vă va permite să selectați punctele dintr-un traseu și 
să le mutați.  
 
De exemplu, să zicem că desenez acea ultimă formă și nu îmi place cum arată. În loc 
să creez un traseu nou complet, pot folosi Instrumentul de Selecție Directă pentru a 
ajusta punctele. 
 
1) Selectați Instrumentul de Selecție Directă și faceți clic pe forma respectivă. Cu 
acest instrument, selectați punctele unul câte unul. Un punct selectat va fi un punct 
de ancorare umplut cu albastru, iar un punct neselectat va avea zona din mijloc albă. 

 
 
2) Faceți clic și trageți punctele de ancorare pentru a schimba forma obiectului. Forma 
arată acum astfel. 



 

 

 
 
Acum, dreptunghiul meu nu se potrivește cu lucrarea de jos, așa că acum doresc să 
ajustez forma dreptunghiului pentru a imita aspectul abstract. Cu Instrumentul Pen, 
puteți de asemenea să adăugați și să eliminați puncte. 
 
1) Faceți clic și mențineți apăsat pe Instrumentul Pen până când vedeți un meniu 
derulant. Selectați Instrumentul Add Anchor Point. 

 
 
 



 

 

2) Acum plimbați cursorul peste traseul dreptunghiului și faceți clic oriunde pe traseu 
pentru a adăuga un punct de ancorare. 
 
 
3) Acest lucru va crea puncte noi de ancorare și veți vedea noi puncte albastre pe 
traseu. Acum puteți folosi Instrumentul de Selecție Directă pentru a muta acele 
puncte și a crea o formă complet nouă. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 

CAPITOLUL 8: 
Utilizarea textului și 
crearea contururilor 

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Acum doresc să adaug textul "Designer Grafic & Artist" peste formele mele. 
 

1) Selectați Instrumentul Text.  
 
2) Faceți clic oriunde și un cursor va apărea pentru a începe să tastați. 
 
3) Odată ce ați terminat de scris, faceți clic pe Instrumentul Selecție pentru a muta 
textul în jur. Acest lucru va crea o casetă în jurul textului. Plimbați-vă peste ea și veți 
obține un cursor care vă va permite să mutați textul pe artboard. 

 
 
4) După ce l-am plasat peste opera mea de artă, pot da dublu clic pe el pentru a 
evidenția textul și a schimba fontul/mărimea folosind bara de instrumente de sus. Am 
schimbat fontul meu la "Modern No. 20", dimensiunea de 22pt. 

 

 
 
În unele cazuri, veți dori să convertiți textul în contururi. Acest lucru vă va permite să 
manipulați textul în moduri interesante. Cu toate acestea, nu veți putea utiliza 
Instrumentul Text pentru a schimba ce spune textul după ce l-ați transformat în 
contururi. 
 
1) Pentru a converti textul în contururi, faceți clic pe text cu Instrumentul Selection. 
 



 

 

2) Du-te la Type > Create Outline (Tip > Creați Contururi). Acest lucru va crea 
contururi în jurul fiecărei litere individuale. Cu toate acestea, textul este încă grupat 
împreună. Pentru a manipula fiecare literă în mod individual, va trebui să degrupați 
textul. 

 
 
3) Du-te la Object > Ungroup (Obiect > Degrupați). 
Apoi, veți putea să selectați fiecare literă individual și să schimbați dimensiunea și să 
dați literelor culori de umplere/contur diferite. 

 
 
4) Faceți clic pe litera G cu Instrumentul de Selecție și măriți dimensiunea tragând 
colțul. Mențineți apăsată tasta Shift în același timp pentru a vă asigura că păstrează 
aceleași proporții. 
 



 

 

5) Rotați litera folosind Instrumentul de Rotire . Ar trebui să puteți face clic și 
să rotiți obiectul așa cum doriți. Am făcut acest lucru atât pentru litera G, cât și pentru 
litera A, așa cum este prezentat mai jos: 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 
 
 
 
 

CAPITOLUL 9: 
Export 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Acum că am finalizat logo-ul meu, pot ajusta 
artboard-ul corespunzător pentru a se potrivi în jurul 
logo-ului meu. Acest lucru este crucial dacă doriți ca 
imaginea dvs. să fie exportată cu anumite dimensiuni de 
margine în jurul ei. Cu toate acestea, în acest caz, voi 
exporta ca .png pentru a permite imaginii să aibă un 
fundal transparent. 
 
1) Du-te la File > Export… (Fișier > Export…) 
 
 
2) O nouă fereastră de dialog se va deschide care vă 
permite să dați un nume fișierului și să selectați formatul. 
Am ales PNG. 
 
 
 
Observați că există caseta de selectare "Use Artboards" ("Utilizează Artboards"). 
Acest lucru este util atunci când doriți ca exportul să se facă folosind parametrii 
artboard-ului. (adică nimic în afara artboard-ului nu va fi exportat ca parte a imaginii). 
De asemenea, este util atunci când aveți mai multe artboards într-un fișier. Cu mai 
multe artboards, va exporta imaginea cu ceea ce ați numit imaginea și -01, -02, etc. De 
exemplu, dacă am numele "Logo" pentru fișierul meu și am 4 artboards diferite în 
fișierul meu, se va exporta ca "Logo-01.png", "Logo-02.png", etc. 
 
3) După ce ați terminat, faceți clic pe Export. 
 
4) În funcție de formatul pe care 
îl selectați, o altă fereastră de 
dialog poate să apară și să vă 
ofere mai multe opțiuni în ceea 
ce privește calitatea și 
dimensiunea fișierului de 
imagine. Acest lucru depinde 
de ceea ce aveți nevoie pentru 
imaginea sau opera dvs. de artă. 
 
 
 
 
 
 



 

 

 
 
 
 
 
 
 
 


